Section 3: Survey design

Fiona Maisels and Rostand Aba’a

Extrait du version Francais de :

Maisels, F., and R. Aba'a. 2010. Section 3: Survey design. Page 16 in M. Kuhl H., F., Ancrenaz,
M., and Williamson, E.A. , editor. Best Practice Guidelines for Surveys and Monitoring of
Great Ape Populations. IUCN Ape Species Specialist Group.

1. 1l est impératif de mettre Distance en Anglais. Pour cela, il faut aller & « Démarrer », « Parametres »,
puis cliquer sur «Panneau de configuration ». Ensuite, cliquer sur « Options régionales et
linguistiques » ;

2. Apparition d’une nouvelle boite de dialogue cliquer sur « Options régionales » et choisissez la
langue « Anglais (Royaume-Uni), en « Appliquer » et « OK » ;

ptions régionales et linguistiques X

Dptions régicrales | Langues | Options avancées |

Standards et farmats
Cette option madifie la fagon dont certaing programmes affichent les nombres,
s monnaies, les dates et les heunes,

Sélectionnez un élémant pour afficher ses paraméties ou eliquez sur
Personnaliser pour choisir vos propres formats ;

|.ﬁnglais IR ayaume-Lni LI Perzonnaliger,., |

Exermplas

Nombre : f123,456,769.00

Symbale marétaire ; |a1 273,456,789.00

Heure : [12:34.04

Date courte ; |1 1412/2009

Date longue : {11 December 2009
 Emplacement

Four aider les services & wous fournir deg informations telles gue les actualités
et la météo, zélectionnez vatre emplacement actuel

France bl |

ak I Annuler | Appliguer |

3. Créer un dossier qui porte le nom « Study design » ou Plan d’échantillonnage ;

4. Créer dans ce dossier, les dossiers qui portent les noms des zones dont vous voulez faire le plan
d’échantillonnage ;
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5. Ouvrir Distance 5.0 en cligquant sur son icﬁneE Distance 5.0
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HE Microsoft Office Word 2003

Trend Micro Internet
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6. Créer un nouveau projet en allant sur « File », « New Project », puis cliquer dessus ;
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7. Apparition d’une boite de dialogue ;

8. Localiser le nouveau projet dans le dossier correspondant a sa zone et donner un nom audit projet.
Ensuite, cliquer sur « Create » ;

Ervegistrer dans - |rj|.D|Je :J@f_‘?'
Mom du fichier : [test_desgn_lopé Create
Type: [ Distance Projects [*.dst) > Annuler

[ Save this folder as the default for Distance projects

9. Apparition d’une nouvelle boite de dialogue

10. Choisir « Design a new survey », puis cliquer sur « Next »
11. Apparition d’une nouvelle boite de dialogue ;

12. Cliquer sur « Finish »

New Project Setup Wizard - Step 1: Type of Project

Westem tamier (Tamivs hancamus)
seen dudng 2 lime tensect swnney
of mammals v Sahak, Malysiz 7 Exit this wizard and set up the project file marually
FPhobo: Mockayat Akwad

The new project "Study_design_birougou’ has been created.

Distance can now help vou to set up the project ready for

use. Select from the options below, and click on the: 'Next' : The survey design setup facility in Distance is currently quite
button to step through each of the screens that follow. lirnited.

If o are nat sure what to enter at any paint, click on the e i Distance will create a global data layer, containing one
"Help' button or press F1 to find out more about the options. : : record, Yiou can then enter the co-ordinates of your study
area in the Data Explorer, by double-clicking on the word
'Palygon’ in the Shape field. Alernatively, pou can link to a
pre-existing shapefile by editing the project file database
manually. An impoart Facility for shapes is planned for a future
release.

| want ko

" Analyze a survey that has been completed

25ign a hew survey

After creating or importing the study area (and stratum)
information, go to the 'Designs' tab of the Project Browser to
beqin creating new survey designs.

£ Use an existing Distance project a3 a bemplate

Import a project or command file created in a

revious version of Distance ] - .
i Click, Finizh' to continue,

Stymfozs mode! of desedt tofodse
(Gophens Fga5sizi) veed for

¥ | Project will contain geagraphic information traiming, Mevads, USA.

FPhoto: Ror Wzdow

LCancel | < Back Mest » | Firish | Help LCancel < Back i i
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13. Apparition d’une nouvelle boite de dialogue ;
14. Configurer le nombre de strates, si la zone a échantillonner en comporte. Pour cela,

15. cliqué sur cette icdne « Create a new data layer » l=. :

. Distance - test_desgn_lopé

File Wiew Tools Data ‘Window Help

ne B @Ee &

£:| Project Browser

(2 Data ]. Maps ] [, Desions ]ﬂ
BE & 8 FRE DEn mml
| Data layers | Prwbamte ok Rlehal lanar 'Shudy ares’

_Create MNew Data Laver

ID| Shape
0| Shape
n'a n'a
Int | [Geog
1| Polygon

16. Apparition d’une nouvelle boite de dialogue ;
17. Donner le nom « Strata » sur « layer name », puis « Ok »

e |
Laper name: |y
Fererisfeyer i::tuay EE] j
Layer type: ISlralum ﬂ Froperties... |
— Data tables

[¥ Create new tables for layer
[v Cieate internal data table within project file

[+ Create shapefile (geographic data table)

Mame: |N,3;,,\._|_a,5JE v Unique
Folder: IC:\DDcuments and Settings\ad Browse, .
Shape type: [Palygon =l

Coordinate  [No coordinate spstem

gk

Ok I Eancsll

18. Apparition d’une nouvelle boite de dialogue ;
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19. Cliquer sur une des cases vide du tableau qui apparait, puis en cliquant le nombre de fois qui

B2

convient sur «Insert New Record Before Current »

, vous ajoutez le nombre ligne

correspondant au nombre de strate de votre zone d’échantillonnage ; dans notre exemple, il ya 3
strates ;

. Distance - test_desgn_lopé - Distance - test_desgn_lopé

File Wiew Tools Data ‘Window Help
e 8 888 &

£ Project Browser

File “ew Tools Data ‘window Help

e @ & 88 &

£ Project Browser
J B Data ]. Maps ] B, Desians ]M Surveys ]
@ oa | s | . Desians MmE o s 55 ADR =Eno
E E 0 @ 15 ‘l‘§ E m B Q E m | Data layers | Contents of Stratum layer 'Strata’ and Insert Mew Record Before Current l—
ﬁ Study area Study area Strata

[ Data layers | Contents of Stratum laver 'Strata’ and all fields fro BR stata ID | Shape | ID | Label | Shape

- Study area Study area Strata '? Shj'pe 'E La?d Shj'pe

BH Strata ID | Shape | ID | Label Shape A B i S

Int Geog Int Int Geog

I | Shape | ID | Label | Shape 1 Polygon

nia nda nfa| nda nda 1| Palygon 2| Default | Palygon

Int Geog Int 3| Default | Palpgan

1! Palygon

20. Fermer ensuite Distance 5.0 tout en sauvegardant les modifications faites
21. Ouvrir ensuite ArcView 3.2 en allant a « Démarrer », « Tous les programmes », « ESRI », ArcView

ArcYiew GIS 3.23

GIS 3.2a, et sur son icone -

Trend Micro Internet Security

) .. " hssistance & distance
i i j Administrator | s
i Y &) Windows Media Player
3, indows Messenger i ArcYie 53
(1| Courrier électronique . . . . T
~|—i‘-| Microsoft Office Dutlaak @ Windows Movie Maker - (7] Arc\-‘dEmplacement 1 HYESRILAY_GIS30ARCYIEWBINGZ
Catalyst Control Center » FRCET l é Arciiew Readme File
é ESRI's Wi Home Page Distance P iewrs. 20 @ ESRI's WWW Home Page
Jeux 3 Q Impark
|T—m Micrasoft Office Word 2003 Microsoft Office N Q Import71
@ Trend Micro Tntarnet Mozilla Firefox » Q MIF To Shape
A Security PDFCreator » g Portiap
ﬁ Distance 5.0 u Adobe Reader & 'Q Projection Utility
& TInternet Explarer @ Readme Datahase Access
\g Mk W msh %5 Rpcinfo
@ Outlook Express & SDTS Paink ta Arc
e windows Media Player @ syncTayz.0 £ 5075 Raster to Grid
Garmin Q Shape DXF Converter
g Spatial Analyst Readme
Tous | .
i Seagate Crystal Reports
ﬁ| Ferme LIPS SAYE PLUIS
— Francais (Fr 13

MIST j
f3 démarrer [ . [N B
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22. Apparition d’une boite de dialogue ;
23. Cliquer sur « Cancel », puis aller a « Views » puis « New » ;

2 ArcView GIS 3.2a
File Project Window Help

ey 2

File  Project  ‘window Help

Tahles - . .
@ = ( Open an exsting poject
Charts

¥ Show this window when ArcView Gl

Charts
0K Cancel @
Layouts
]
Scripts z ¥ Sciipts Z z

24. Apparition d’une nouvelle boite de dialogue ;
25. Ajouter sur la fenétre « View », la couche de la zone a échantillonner, en allant a « Add

2
Theme » :
' ArcView GIS 3.2a

File  Edit View Theme Graphice indow Help

A A0 &
I@ I I o] R s i Scale 1
<2 Untitled !E'

— (O

PN NN _ VN

26. Apparition d’une boite de dialogue ;
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27. Aller dans le dossier ou sont localisés les Shapefiles de la zone a échantillonner. Cliquer sur le
Shapefile qui convient et appuyer « Ok »

! Add Theme

Directan: | higistlope Ok

lopegongue. shp

[= b g Cancel
= oz M

rr.shp
natiohalparkz. shp 7 latlang

[ waka_lope_comidardd
* Directories

—{ " Libraries

parcellensf. shp
parcellensfs. shp
parceles. sho

=
=
E pshp
=
=
=

£ =

Data Source Types: Drrives:

[ e |

L4l

| Feature Data Source

B : Il est impératif que les Shapefiles et bien sur la vue soient en UTM. Si ce n’est pas le cas, veuillez
les projetes en ces unités.

28. Apres avoir active le theme, nous obtenons ceci ;

2 ArcView GIS 3.2a

File Edt Wiew Theme Graphice ‘window Help

8) (3) S Bl e
-: P o

3% E€

Scale 1

“Z Untitled

— O] =

ﬂ Lop enp-utm32 shp |

1

29. Convertir ce theme en Shapefile et lui donné le nom « Study_ar ». Pour ce faire, il faut d’abord
cliquer sur le Theme, puis aller sur « Theme », puis « Convert to Shapefile » ;
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x
Directones: 0K |
o hdocume ™1 hadmini ™1 %locals ™1 \ter

I = o\ Cancel
= docume™1
= admini~1

= locals™

£ __skypeistoolbar_cache
—_ 7 bin%copy®1
= ™ aarmin software uodates LI

Dinives:;

[= =

30. veuillez localiser le Shapefile dans le dossier correspondant a la zone a échantillonner ;

! ArcView GIS 3.2a
File  Edit i ANCIEN Graphics

E: Eroperties. ..

Windgw Help

Start Editing

Edit Legend...

Select By Theme. ..

i ] Lope Hide/Show Legend
i
ﬁ futo-label.. CtrkL
T:
T
Ct Table...
ﬁ Cuem. Chil+(3 3
La

Clzar Selected Features

~]|

[y}
= )

31. Ouvrir le tableau des attributs de ce theme,en cliquant d’abord sur le theme, puis sur I’icéne « Open

Theme Table » I
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i Arc¥iew GIS 3.2a

Eile  Edit Table Field ‘Window Help

1) GJF)

| 0 of | 17 zelected u ;
#! Attributes of Nationalparks.shp
Shana A Al Aaas L Flanmatar Hactanas

i Polygon 1{PM Mwagné TEYY 187 km 1.688 0.0
Palygon 10: PM Mayumba 11 a0 km 1.429 0,001
Palygon 21 PM Mpazza IF547 303 km 2729 0.0
Palygon 3 PN Ivindo ajnin? 425 km 3834 0.00
Palpgon 4 ¢ P Biringou IPlo 151 km 1.364 .00
Palygan R iPM Waka q3lln, 397 186 km 1.692 0,001
Polygon 6: P ML Seni [<BiBE? 130 km 1.1E60 oo
Paolpgon 1]

Faolygon 7 i PM Mbe !R,}‘.q 205 km 1.848 0.am
Palpgon 2! PM Loango REALS? M2 km 2.821 .00
Palygon 9: PM Moukalaba Dou: E= B33 km B.705 0,001
Palygon 13 PN Minkebe MTIE? 722 km G.515 0.0
Folygon 0:PM Lopé 1med? 471 km 4 255 0.0
Palpgon 0 PM Wongue Wongy O+ ie0? 436 km 3.933 oo
Palpgon 12 PM Pongara il EY 338 km 3.051 .00
Palygon 11 ¢ PM Akanda I L 137 km 1.237 .00
Paluaan il GNES] 0777 o.om

32. Eliminer toutes les colonnes sauf la colonne « Shape » ; éliminer toutes les lignes sauf la premiere ;

33. Pour éliminer ou ajouter les colonnes ou les lignes il faut d’abord aller a « Table », puis « Start
Editing » ; puis aller a « Edit » puis « add Field ou Record» ou « Delete Field ou Record

W— @ Arc¥iew GIS 3.2a
! BE Field indow  H File Table Field ‘window H
- Properties.. g Tt ik jl@
= LChart... B [Copy [Ctr+C .
= Faste [Etr|+4) ozl
E $ave Sdis UndoEdit  CilsZ %
g weBdiAn. o RedoEdit  Cilsy
Eind.. Ctrl+F Add Field... N
Duery... Chel+0
J [Chrl+d [relete Becords
Eemave £llJos Selact Al
Select Mone
Femave Al Link Sole Switch Selection
A Pl T o
i u Palygon 97PN Moukalaba Diou
13 PN Minkebe Palygan 131 PN Minkebe
0 PN Lopé Palygon 0} PN Lopé
0] PN Wangue \Wongy Palygon 01 PN 'Wangue Wongy
12| PN Pangara Palygan 12| PN Pongara
11| PN Akanda Palygan 11| P Akanda
o Palygon 1]

34. Créer une nouvelle colonne, donner lui le nom de « LinkID » et affecter le chiffre « 1 » en dessous

Extrait du version Frangais de :

Maisels, F., and R. Aba'a. 2010. Section 3: Survey design. Page 16 in M. Kiuhl H., F., Ancrenaz, M., and
Williamson, E.A. , editor. Best Practice Guidelines for Surveys and Monitoring of Great Ape Populations.
IUCN Ape Species Specialist Group.



Mame: | NewField] [ """""""" G J

Type: | Murmber |

Width: | 16
Decimal Places: | 1

35. Pour écrire sur le tableau, il faut cliquer sur « Edit » la case du tableau dans laquelle vous voulez

D
écrire e :

' ArcView GIS 3.2a

File Edt Table Field “Window Help

[£][g]
| ] 0f| 1 selected “E]
W_V:ITH
20 Viewl !E #7 Attributes of Study_ar !E
- ﬂ N B Shape
= i Doledon 2 1 =
|
= ‘ 51
=cnpis ¥ Pkl |

36. Mettre ledit Shapefile dans le dossier de la zone a échantillonner ;

37. Convertir le méme Theme en Shapefile mais en lui donnant le nom de « Strata ». Le processus de
conversion est le méme qu’a la manipulation précédente ;

38. Sur le Theme « Strata » faites des strates en cliquant sur le Theme, puis aller a « Theme », puis
« Start Editing ». Ensuite, aller a « Draw Line to Split Polygon » et choisissez I’avant derniere option
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39. Couper a I’aide de la souris les différentes strates de votre zone d’échantillonnage, en cliquant sur le
vue a I’endroit ou vous voulez commencer la limite de la strate, puis glisser avec la souris sur la
limite, jusqu’a la fin de la limite. A cet endroit, cliquer deux fois

le Edit “iew Theme Graphics ‘Window Help

INEANE N
Wl [0 E

Edit “iew Theme Graphlcs Wlndow Help

A0 ¥ @sle) B

| Study_ar _ | study_ar

@ ArcView GIS 3.2a

File Edt Table Field ‘indow Help

| 0 Df| 3 selected “m

£ tributes of Stata shp C
Shane Ll -

o - j ﬂ Strata.shp -

Fal Z

e 3 7

40. Ouvrir le Tableau des attributs du Theme « Strata» et donner des numéros 1; 2:; 3;...aux
différentes strates, selon le nombre de strate congu ;

41. Fermer Arciew ;
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42. Aller dans le dossier correspondant a la zone a échantillonner, copier les deux Shapefiles
« Study_ar » et « Strata » pour les coller dans le dossier du projet Distance que vous avez créée. Il va
vous demander si vous voudriez remplacer les fichiers existants. Appuyez sur « Tous » ;

Eichier ~ Edition  Affichage  Faworis  Qutils 2

@Précédente - -\_:j LE pRechercher EE:‘ Diossiers v

Adresse |E} H:\Documents and SettingsiadministratoriDesktoplStudy designiLopé

Dossiers x Marn Talle | Type Dake de modifica...
@ Eureau [Ctest_desan_lopé.dat File: Folder 10/12{2009 13:01
Mes dacuments test_desgn_lu:npé 264 Ko Distance Proj...  10/12{2009 13:01
= Poste de travail 1Ko Fichier DEF 10/12/2009 13:47
% Disque amavible (C:) 1Ko Fichier SEM 10{12/2009 13:47
%= Disgue amavible (D) 1 Ko Fichier SB% 10{12{2009 13:47
< Disque amavible (F:) 11Kn  Fichier SHP 10/12/2009 13:47
2, Lecteur DVDJCD-RY (G1) 1Ko Fichier SHx 10/12/2009 13:47
<@ Disque local (H:) 1 Ko Fichier DEF 10/12/2009 14:02
% Disque amavible (L) 1Ko Fichier SEM 10{12/2009 14:02
B Panneau de configuration 1Ko Fichier SEX 10/12/2009 14:02
T3 Documents partagés 11Kn  Fichier SHP 10/12/2009 14:02
) Documents de Administrator 1Ko Fichier SHy 10{12/2009 14:02
©3 Documents de User 1 7Ko  Fichier APR. 10/12/2009 14:04

‘g Favaris réseau
& Corbeille
= () study design
EJ Birougou
= 3 Lopé
[C5) test_desgn_lopé.dat

5 waka

43. Ouvrir le projet Distance qui est dans le dossier correspondant & votre zone d’étude
| 4. Detest_desgn lopé g cliquant dessus, puis cliquer sur « Maps » B8 Maps

- Distance - test_desgn_lope

J File Wiew Tools Data ‘window Help

heE B e sa g

5 Project Browser

@ Data ]. taps ]L Deszigns ]M Surveys ].-’-‘malyses ] w Simulations ]
AE O & FSE BEN mEn
| Data lapers | Contents of Global layer 'Study area’
E--. Study area Study area
B Shata ID | Shape

ID | Shape
nfal  nfa

Int | Geog
1! Palygon
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44. Puis sur « New Map » i. :

. Distance - test_desgn_lopé

| Fle Wew Took Maps Window Help
neE B e a8 Z
#| Project Browser,
@ Data " Maps ]k Designs
ME @ @anm|

I

] i Surveyps | [

Mew Map

nEg 8 e &8 g

roject Browser

] F Simulations

46. Choisir la couche a afficher et cliquer sur « Ok »

Add Map Layer

Layer name:
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47. On obtient ceci

- Distance - test_desgn_lopé - [Map 1: [New Map]]
B Fle View Toos Map Window Help
neg @ & 88 F
FORe BE ~F F GRLQM M

[v Study area

[+ Strata

P75

48. Si vous avez les strates, ajouter les de la méme maniére que vous aviez mis “Study_ar”, ensuite
fermer la page carte ou « Maps »

Add Map Layer X|
Layerrame: [T TYRG— - |

LK Lancel
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49. S’il n’y a pas les strates dans votre dessin, fermer la page Map, tout en acceptant de sauvegarder la
nouvelle carte ;

50. Aller a « Data » [ Data , puis « Create a Naw Data Layer » F,
Cliquer dessus, il apparait une boite de dialogue ;

Mew Layer Properties

Layer name: | G5id

Parent layer: |5tun:|_l,l area j
Laver type: |Enverage j Properties... |
D ata tables
[
[v Create internal data table within project file
-
M arne: |Gri|:| W Lnique
Folder: |H:HDDcument3 and SettingsAad Browsze...
Shape type; |P'|:|ir'|t j
Coordinate Mo coordinate system
spztem;
ok Cancel

51. Dans « Layer name », écrire « Grid » et dans « Layer type », choisir « Coverage » ;
52. Apres ces choix, cliquer sur « Properties », il apparait cette boite de dialogue ;
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Grid Properties E'

Theze zethings are uzed o generate a gnd of paints in the new
coverage of prediction data layer.

Projection for gnd calculations: | J

Diztance between grd points: ||3|:||:||:|

Unitz of distance: Meter B

Defat | BT cancal |

53. Sur « Distance between Grid points », mettre la distance qui vous convient,

54. Par défaut, les unités de distance sont en meétre, soyez vigilant en mettant le nombre et I’unité
d’espacement des points dans le Grid. Dans notre exemple ci-dessus a un espacement de 6000
meétres (6 kilometres).Puis « Ok » ;

55. Ajouter la couche Grid en allant sur la page Map et « View Map » n ; puis cliquer sur « Add Layer

to Map » =il apparait une boite de dialogue ; choisir dans « Layer name » Grid, puis « OK » ;

Add Map Layer x|

Layer name: I Giid -

[ """"""" gr ] Cancel

56. Il apparait sur la vue map la Grid, fermer la vue Grid,;

Extrait du version Frangais de :

Maisels, F., and R. Aba'a. 2010. Section 3: Survey design. Page 16 in M. Kiuhl H., F., Ancrenaz, M., and
Williamson, E.A. , editor. Best Practice Guidelines for Surveys and Monitoring of Great Ape Populations.
IUCN Ape Species Specialist Group.



“ Distance - D6test_desgn_lopé - [Map 1: [New Map]]

BB Fle Yew Tools Map Window Help
neg =3 8las 2
Z06e BB 5 08 QRN W

v Grid
o

[V Strata

¥ Study area

Cliquer sur « Designs » sur cette page [, Designs

2 Distance - test_desgn_lopé - [Project Browser]

B File Wiew Tools Maps Window Help

he 3 e ®es g
[ Data | BB 1 aps ]LDesigns ]M Surveys ]f—‘-.nalyses ] i Simulations
mE  awB |
1D M ame:

57. Cliquer sur « New Design » i., double clique sur le rond &= 3 gauche de « New design »
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. Distance - test_desgn_lopé - [Project Browser]

B8 File Wew Tools Designs Window Help

Ne @ 8&a g

(@ Data 1. Maps .hDESiQHS ]ﬁ Surveys
Set Set v = dEm % Design: K K n @ @ R EE

58. Il s’affiche la boite de dialogue ci dessous, préciser dans celle-ci le type d’unité d’échantillonnage
sur « Samples » et la classe des unités d’échantillonnage dans la rubrique « Class ». le carré bleu
- -

E‘.‘.‘ en bas des « Properties » donne une idée du type plan que produira le logiciel avec les
différents choix ;

59. Cliquer sur « Properties »

k File Wiew Tools Design-Inputs ‘Window Help

Iz

Neé 8@ 88| 2

Design
Hame: |New Design LELT |
Created:  15/12/2009 10:54:06
Run:

Tupe of Design E
Sample IL‘HE ] J Properties ... |
Class: c Eenmerted | 1ack e Garmping j i

Description
|7 The systematic zegmented parallel line zampling design randomly superimposes a systematic set of seamented parallel lines onto the survey region. & zet of parallel tracklines i used for thiz purpoze.

60. Il apparait une nouvelle boite de dialogue pour les transects ;
61. Cliquer sur « Effort Allocation » ;
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Design Properties: [Mew Design] Set: [Set 1]

General Properties | Effort .ﬁ.llncatinn] mpler] Coverage F'ru:ul:ual:uility]

Straturn Layer; Isnata ﬂ

Coordinate Spstem Description: Maon-earth in keter unitz.

— Dezign Coordinate System
¥ Same coordinate system as shatunm

f+ Mon-earth referenced

i~ Geographic |[N-:une] coordinate syztem
" Projected fram the I[Nl:nne] geographic coordinate system
uzing the I-"-"-ittlff ﬂ projection in | Meter LI Linitz

Frojection parameters ..

— Randam Mumber Generataor

Seed: * from system clock £ preset to ||:|

Defaultz | ok LCancel

62. Il apparait ceci ;

63. Choisir les parametres de votre plan d’échantillonnage, choisir par exemple les kilométres dans
« Length units », préciser la longueur des transects des unités d’échantillonnage dans « Segment »,
I’espace entre les unités d’échantillonnage dans « Spacing » et I’angle des unités d’échantillonnage

dans « Angle »
64. Vous pouvez désactiver « Same effort for all strata » pour que chaque strate ait un effort différent ;
cliquer sur « Ok », puis « Run ».

Extrait du version Frangais de :

Maisels, F., and R. Aba'a. 2010. Section 3: Survey design. Page 16 in M. Kiuhl H., F., Ancrenaz, M., and
Williamson, E.A. , editor. Best Practice Guidelines for Surveys and Monitoring of Great Ape Populations.

IUCN Ape Species Specialist Group.



Design Properties: [Mew Design] Set: [Set 1] X

General F'ru:uperties‘ Effort .&.Ilucatiun] Sampler] Coverage F'ru:ul:ual:uilit_l,ll

—Edge zampling———  Mon-conves survey regions
& Minus = Plus [T Usze a minimum bounding rectangle

— Sampler segment handling
f* Keepcomplete zamplers ¢ Allow split samplers [ Extend ncomplete samplers

[T Dizcard zplit sampler =egments less than |25 % of the complete segment length

— Allacation by stratum

Length Urits IMeter j Total lines ||:| Total length ||:|
v Same effort for all strata v Update effort in real time | pdate Effart |

™ Abzolute values for Isampler segments ;I

™ Percentage from ||:| lines ¥ Integer Tatals
% Spstematic ine spacing v Same spacing between segments and lines
Id Label Samplers | Length Effort % Spacing | Segment | Angle

1 | Default 0 1] 0 0 ] 0

2 | Default 0 1] 0 0 ] 0

3 | Default 0 1] 0 0 ] 0

Defaults [n] 4 LCancel

i

65. Il apparait cette boite de dialogue, cliquer sur « Create a new survey and generate a new sample data
layer for the survey, based on this design », cliquer sur « Ok » ;

Extrait du version Frangais de :

Maisels, F., and R. Aba'a. 2010. Section 3: Survey design. Page 16 in M. Kiuhl H., F., Ancrenaz, M., and
Williamson, E.A. , editor. Best Practice Guidelines for Surveys and Monitoring of Great Ape Populations.
IUCN Ape Species Specialist Group.



Run Design 3: [Mew Design] IE|

5 Lalculate coverage probability statishics for this design, and
gave rezultz in a new field in a coverage grid data layer.

Cowverage grid

Laver name: Grid

Mew field name: Mew Desigh

Create new Survey and generate a new zample data layer for
the zurvey, bazed on thiz design

— Mew sunvey

Survey et I Gt 1 ;I

Mew survey name: |New Design

¥ Open Survey Details window during run

Mew laver name: |New Diesigh

Q. Cancel

66. Puis «Run »

h File ‘iew Tools Design-Inputs Window Help

neglBees d
Design
Mame: INew Design

Created:  15/12/2009 10:54:08

Rur:

Type of Design

Sampler: I Line

-
J Properties ... |
Class: ISystematic Segmented Trackline Sampling j

Description
’7 The spstematic segmented parallel line zampling design randomly superimposes a systematic set of segmented parallel lines onto the survey region. A set of parallel tracklines is used for this purpose. ‘

67. Vous obtenez ceci ;

Meetez ici la page avec la Grid (jaune et rouge)

Et ensuite mettre ceci
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i~ Calculate coverage probability statiztics for this design, and
gave rezultz in a new field in a coverage grid data layer.

Cowverage grid
Laver name: Grid

Mew field name: Mew Desigh

Create new Survey and generate a new zample data layer for
the zurvey, bazed on thiz design

| [~

Q. Cancel

2Z Distance - test_desgn_lopé - [Survey 1: [New Design] Set: [Set 1]] |Z||E|P5__<|
@4 File Wew Tools Survey-Results  Window Help .= ﬂ

Heé 8 888 F

| Design engine output j Mext »

Survey Plan Results: s

DESICGH CLAZS: Systematic Seqmented Trackline Sampling
SAMPLER CLASE: Line

3
SAMPLE LAYER: MNew Design E
STRATUM LAYER: Strata &
Effort definition by Spacing.
EFFORT UNITS: Eilometre
Deal with boundary regions by using Minus sampling.
Generate the design within the survey region itself even if it is non-conwve:x.
Design uses Complete Seqments.
COVERAGE PROBABILITY GRID: Assume ewen | ]
GRID LAYEER NAME: Grid
COVERAGE PROEAEILITY FIELD NAME: New Design
STRATUM LAYER COORDINATE SYETEM: Non-earth
DESICN COORDINATE SYSTEM: MNon-earth
DESIGH UNITS: Meter B
ING SEED VALUE: 152523 (FROM SYSTEM CLOCE)
)
{=]

STRATUM 1 - Default

APPROMIMATED LINE TOTAL: 132

SEGMENTZ GENERATED: 10

SAMPLER WIDTH: 1 Meters

ESTIMATED ON EFFORT TRACELINE LENGTH: 32 Kilometres
LREALIZED ON EFFORT TRACELINE LENGTH: 20 Kilometres
EXPECTED SAMPLER AREA COVERAGE: &0000 scuare Meters
SEGMENT LENGTH: 3 Filometres

SEGMENT SPACING: 9 Eilometres

TRACELINE SPACING: 2 Hilometres

TRACELINE ANGLE: 90 degrees

TOTAL TRACELINE LENGTH: 132,212 Kilometres

The total trawel path starts at the beginning of the first sampler line.
TOTAL CYCLIC TRACELINE LENGTH: 174,37Z Eilometres
REALIZED SAMPLER AREA COVERAGE: &0000 scuare Meters
STRATUM AREA: 1zZ00394656,747 square Meters
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68. Appuyer sur « Next » pour voir une ébauche préliminaire de votre plan d’échantillonnage

7 Distance - D6test_desgn_lopé - [Survey 5: [New Design 3] Set: [Set 1]] ;lgl_"

@ Fle Yiew Tools Survey-Results Window Help =l
LEEIREEIE -
Survey map j < Back | ﬂsxb

#FORR BE G W

[¥ Mew Design 4

[ Shata

sndu|

[~ Study area

Bo

_omments

69. En appuyant sur « Next » encore, vous obtenez les Waypoints des débuts et des fins des transects, en
UTM
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.7 Distance - Dbtest_desgn_lopé - [Survey 5: [New Design 3] Set: [Set 1]]

JM File Wiew Tools Survey - Results  Window  Help

| neE 2 e se Z

I Sampler location hist

Sawple layer name:
Type of sampler:
Muwbher of samplers:

List of samplers:

Sawpler 1

Sampler £

Sampler 3

Sampler 4

Sampler &

Sampler &

Sauwpler 7

Sawpler 2

Sawpler 2
203745 .6 —-2E30Z.

201445 1 -13232320.
FIsv04.5 —-1lz110.

S0l4zz.1 -18733.
798681.4 —-17573.

794113.7 -15539.
FI1373.1 -14319.

7858923.9 -11879.
783153.3 -1l0655.

77E1z3 -1ZEE7_EZ2
7ITEEE . —13777.

78z431.3 -1E5211.
7e8EL7E -17031l.62

7897357 -120&E5.
79z480.3 -zZ0E8E.

Ta7042.1 -222139.
72978287 -23E39.

New Design 4
Line
z41

x—-coord y-coord

Ed
232

43
22

54
33

a7
=1

]

4l

232

70. Sélectionner (Ctrl+A) et copier (Ctrl+C) ces coordonnées, puis coller (Ctrl+V) les dans une page

Excel.

71. Organiser les données de telle sorte que vous ayez une fiche comme celle a droite, avec numéro de
transect, numéro de waypoint, si le point est le début ou la fin du transect, et les deux colonnes pour
les coordonnées X et Y (en UTM) ;
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Microsoft Excel - Classeurl Microsoft Excel - waypoint debut et fin transect dd

Eﬂ Fichier  Edition  Affichage Insertion Format Outils IZ‘J Fichier  Edition  Affichage Insertion Formak  Qutils  Données  Fepfbre
NEHRS I SRAITH & 2RI NEHRIERIPH| ¥ RR-F9-0-8
B12 - = H12 - &
A, | = [ [ D A B | & [ o | E ] F

| 1 |Sample layer name: MNew Design 5 | 1 |TRANSECT MéAYPOINT DEBUT_FIMN UTK_ X UTK_Y
| 2 |Type of sampler:  Line | 2 | 1 1 Debut 80144510 -13330.54
| 3 |Mumber of samplers: 33 | 3 | 1 2 Fin F93704.500 12110.33
EN EN 2 3 Debut 801422100 -18793.43
| & |List of samplers: | 5 | 2 4 Fin 7H98651.40 -17573.22
| B | x-coord y-coord | B | 3 5 Debut 794113.70 -15539.54
| 7 | 7 3 6 Fin 791373.100 -14319.33
| 8 | Sampler1 | & | 4 7 Debut 7858593.90 -11879.587
| 9 | BO08587.6-17036 1 9 | 4 8 Fin ¥83153.30 -10659.66
| 10| 796319.9 -15002 32 |10 | 5 9 Debut J75123.000 -12557.52
| 11] - |11 | 5 10 Fin J778E3.60 1377773
| 12| Sampler 2 1 12 | 5] 11 Debut 782431.300 -15811.41
| 13| 777697.2 -16562.68 | 13 | 5] 12 Fin 78517200 -17031.62
| 14 | 782264.9 -16596.56 | 14 | 7 13 Debut 789739.70 -19065.30
15| - | 15 | 7 14 Fin 79248030 -20285.52
| 16 | Sampler 3 | 16 | g 15 Debut 797048100 -22319.20
| 17| 790486.5 -22256 99 | 17 | g 16 Fin 799788.700 -23539.41
| 18 | 7950545 -24250 68 | 18 | 9 17 Debut B803749.650 -25302.93
118 - | 19 | 9 18 Fin B06450.530 -26523.14
| 20| Sampler 4 | 20 | 10 19 Debut BO17593.60 0 -29905.22
| 21| B01414.6-27122.36 | 21 | 10 20/Fin 799052.90 -28685.01
| 22| B0599582.3 -29156.04 | 22 | 1 21 Debut 73448530 -26651.33
123| - | 23 | 11 22|Fin F91744.600 2543112
| 24 | Sampler 5 | 24 | 12 23 Debut JE7176.90 23397 .43
| 26 | 7EBBS3 -21510.57 | 25 | 12 24 |Fin 784436.530) 2217722
| 26 | 7712507 -23544.25 | 26 | 13 25 Debut 779865.50 -20143.54
|27 - | 27 | 13 26 |Fin 717800 -18923.33
| 28 | Sampler B | 23 | 14 27 | Debut 772560.10 -16839.65
| 29| 7794726 -27204.85 | 29 | 14 28 Fin 72531950 -15669.44
| 30| 7840404 29238 57 | 30 | 15 29 Debut 7B5251.80 -13635.75
31| - | 31 | 15 30 Fin 7E2511.100 -12415.54
| 32 | Sampler 7 | 32 | 15 31 Debut 7E0B40.590) -17056.04
| 33| V922623 -32599.2 | 33 | 16 32|Fin 7633581.60 -18276.25
| 34 | 796530 -34932.58 | 34 | 17 33 Debut 767949.30 -20309.93
136 - | 35 | 17 34 Fin J706589.90 -21530.14
| 36 | Sampler 3 | 36 | 15 35 Debut F75257 600 -23563.83
37 JEB095.5 -D.?’fi 37 18 36 Fin J779598.50 -24734.04
M 4 » b [\Feuill { FeulZ f Feuil3 M 4 » M| waypoint debut et fin transect
Prét Prék
w Démarrerl |_# Lopé | E}-Pa'naa.lde a4 Démarrerl |3y Study design | [} Panneau de configuration | IEHDI

72. Enregistrer en texte cette fiche Excel.

73. Ouvrir ArcView 3.2, cliquer sur « Cancel » et aller a « Table » EE==, puis « Add » Add ;
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—Ioix

Ele PEroject indow Help

42 Untitled =] B3
o Add

74. Sur la nouvelle boite de dialogue, aller a I’endroit ou vous avez mis le fichier, choisir le bon type de
fichier dans « List Files of Type » (Delimited text (*.txt) dans notre cas.

75. Cliquer sur le bon fichier et cliquer sur « Ok »

i Add Table 41| < Add Table %]
File M arne: Directaries: oK | File Name: Directories: 0K
I e:hesrivay_gis30havhutor i c\documents and settingshadmiristrz —I

- = N - Cancel | ; = o\ ” Cancel
I~ = esi il [ documents and seftings
(= av_gis30 [ administrateur
&= aviutor [ bureau
£ arcview = study design
7 dbaccess
|- 7 spatial | ] détest_desgn_lopé dat
- - l 1 kest deson loné dat ¥
List Files of Tupe: Drives: List 'f_'f_*”' Type: Diives:
FdE.t’-‘l.SE [, dbf) =l e =] | Dedimited Text [~ ] 2 |

76. Il apparait ;
77. Fermer le ce Tableau
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R
ile  Edit Table Field ‘Window Help
= oz | e
=
| 0 of | BE selected
ERTT O o
I <0 debut et fin transect.txt
_q Trnsae] Dedbetd] Memnr| Moo | und
1: Debut 8008876 ¢ -17036.00 1 =
W 1:Fin 7963139 -15002,32 2
ﬁ 2iDébut 7776972 ¢ -1B562.68 3
21 Fin 7822649 -18636,36 4
31 Début 17904868 | -22256,99 5
31 Fin 795054.6 | -24290.68 B
4| Début 18014146 | -27122.36 7 !
ol 4| Fin 8059523 | -29156.04 8
5| Début | 7BEEB3.0 | -21510.57 g
ﬁ 5| Fin 7712507 | -23544.25 10 )
6 Début | 7794726 | -27204.88 11 3
La rlr. TAANAR AL AR BT LR ,,,,,,;I
f, 4 [v]
Scripts E” j I
L
—|
| ]
. . . Mew .
78. Cliquer sur « View » I, puis « New » ;
@ ArcYiew GIS 3.2a i [m]

Eile Project Window Help

S| [

Scripts ¥ =
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79. Nous obtenons ceci

i

i Edit Miew TIheme Graphics indow Help

el
INRNEE 27 =< Ry
Mew ] e | Frird |
Table
|
Charl
I.I.
Z]
Scip L
~ |

80. Ensuite aller a « View » sur la barre de Menu, aller & « Add Event Theme » et cliquer dessus. Dans
la nouvelle boite de dialogue, Choisir la bonne table dans « Table », choisir la longitude pour « X
Field » et la latitude pour « Y Field », puis cliquer sur « Ok »

! Add Event Theme |

! Arc¥iew GIS 3.2a

Scale 1
Table: I
% field: | *-coord B3
¥ field: | Y-coord =]
0k I Cancel |

81. Ouvrir le tableau des attributs de ce theme en cliquant d’abord dessus, puis sur I’icbne « Open
Theme Table »
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@ Arcview GIS 3.2a
Eile Edit Yiew Theme Graphics Window Help

3R E©)

g (%)

|'0| [ | B, |-i'_-||(]0pen Theme Table||'ig5|k€|'|T'

. 722541 7
Scale 1 FL Rt

Z2 Untitled _ O] =]
@ @ Yiewl =l

ﬂ Debut et fin trans sc_*

L4l

82. Nommer cette vue « UTM » (dans View Properties)
83. Il faut alors créer une autre Vue, et nommer la«dd ».

84. Projeter le theme dans la vue en degré décimale. A cet effet, il faut activer I’extension « Projector »
en allant & « File » puis « Extensions » ; choisir (Projector !) ; montrer ou se trouve Projector

Add Theme to: File: M ame: Directaries: . B oK. |
IMM c:\documents and settingshadministre
F — B ch = Cancel |

Cancel

[=r documents and settings
UTM i 1 = administrateur
<Mew Views = bureau

= study design

(£ dbtest_desgn_lopé.dat
= ™7 test desan loné.dat

=

Drives:

fe: =

Ll

85. Cliquer sur le theme et sur I’icbne « Projector » bouton apparu sur la barre de menu. Il apparait cette

boite de dialogue, appuyer « Ok »

86. Sur « Category », choisir UTM 1983 et sur « Type », choisir Zone 32 pour cet exemple (Lopé), puis

«Ok»;
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#2 Projection Properties

% Standard " Custom

Category: [ Projections of the World

Type: [ Geographic
Projection:; Geographic
o proectot x

0 Plassa saleck the inpak projection in the neat dislog bok

87. Dans cette boite de dialogue, choisir « Decimal degrees » et « No », et ensuite « Yes »

Z Projector!

Pleaze pick output unitz

Recalculate area, perimeter and length fields (if present] using
decimal degrees?

Ok

Mo

Cancel

Projector!

9 Add projected shapefile(z] az themelz] to a view?

88. Ajouter a la Vue dd, puis « OK », et ensuite choisir la localisation de votre theme et donner un nom
a ce theme.

i ArcView GIS 3.2a
Eile  Edit Miew Theme Graphics MWindow Help

B F E (IR
EONECS V=R

i dd M[=] B3
] Di_trans.shp = LI ®e
[ ] . L™
o, *a ®*a
e ¥ g .,

b TR T L™
e s we
ee ae

L«
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89. Aller chercher le script qui nous permet de transformer les coordonnees (UTM) en degree decimal,

@

90. Appuyer sur « Scripts » 'seis | puis « New »

pour cela ;

91. Cliquer a Scripts sur la barre des menus, puis « Load Text File »

sl 'indow  Help

Eroperties. .

Compile

Step E&
HLm E5

Toggle Brealkpoint
Zlear &l Breakpoints
Examine Wariables... Chl+E

!_.IIFII_:II'II'II::I:I Eil::li| it

Load System Script...

Load Text File...
Wirite Text File. ..

Embed Senpt

92.Dans la boite de dialogue qui apparait, suivre dans « Directories» le chemin suivant
Clesri\av_gis30\arcview\samples\scripts. Dans la rubrique « File Name », choisir « addxycoo.ave »,

puis cliquer sur « OK » ;

! Load Script

File Mame:

| addepcon.ave

Directones:

chesimvay_gisdlharcviewhsamplesta

addcolor.ave
addcony.ave

0

[ addashp.ave
[ addecnoave
]
0

=

addtheme.ave
addimenu.ave

addsycoo.ave

]

= b -

[~ esii

= av_gis30

= arcview

= samples
sonioks

M aiconnct ave d
List Files of Type:
| Avenue Script =]

93. Il apparait le script
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~lolx|

Fle Edit Scipt ‘Window Help

2 I3 (A= ]

Elpreey ey | end 'if =
- el=z=e 'polygon case
= _ if (project_flag) then
i theFTab.Calculate( " [Shape] . ReturnCente
theFTab.Calculate( " [Shape] . ReturnCente

New
Views else
Tablas

theFTab.Calculate("[Shape] . FeturnCente
theFTab.Calculate("[Shape] . FeturnCente
;nd 'oif
=1

‘Return editing state to pre-script runni:p
Chails theFTab, SetEditable(edit_state)

1] | »

Ll

94. Compiler le Script en allant a « Script » sur la barre de Menu puis « Compile »

GIS 3.2a
m Window Help

ear All Bregkpoints

wamie Yarnables. . Eil+E

Load System Scrpt...
Losd Text File...
‘winte Text File...

95. Ensuite, cliquer sur le theme, ensuite sur le « Script » puis « Run » [i ;
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Scriptl

v_exists

if (% exists or y_exists) then

'if ok to overwrite,
if (x _exists) then

end
if (yv_exists) then

end
else
eHit
end 'if
end 'if

(M=gBox...)

V.
theFTab. dddFields{{=z.v}}

if {project_flag) then
'Projection defined
theFTab.Calculate( " [Shape]
theFTab.Calculate( " [Shape]
else
'Ho projection definsd
theFTab. Calculate(" [Shape]
theFTab. Calculate(" [Shape]
end 'if
else 'polygon case
if (project_flag) then
theFTab. Calculate(" [Shape]
theFTab.Calculate(" [Shape]
else
theFTab.Calculate(" [Shape]
theFTab.Calculate(" [Shape]
end ' if
end

4l |

% exzists = (theFTab.FindField('f-cocrd") =
= (theFtab.FindField("Y-coord")

'as required by this script (eg..

'Get point coordinates or polygon centroid coordi:
if (theThene.GetSrcNane. GetSubHamne =

.ReturnProjected(_tl
.ReturnProjected(_tl

LGetX", =)
GeEtY", v

.ReturnCenter . Retur:
.ReturnCenter . Retur:

.ReturnCenter. GetX"
.ReturnCenter. Get¥"

'‘Return editing state to pre-script running state —
theFTab. SetEditable(edit_state)

if (MsgBox.YesNo('Overwrite existing fields?",
"E—coord., Y-coord fields already exist",
delete the fields as thes

false):

created fror

theFTab . RemoveFields({theFTab. FindField({ "X

theFTab . RemoveFields({theFTab. FindField({"¥—

x = Field Make ("Y-coord" #FIELD DECIMAL 18 5}
= Field.Hake ("¥Y-coord", #FIELD_DECIMAL. 18.5)

"point ") ther

"

T LN ] LR
(=]
Utm = Utmy | aypoint Hrooord “-coord m . .,
8008876 | -17036.00 1 1170300 015396 =] . . -
7963199 1500232 2 1166199 013558 ° . * .
777E07.2 | 1656260 k] 1145481 -0.14970 w® 0p  » R °
7822649 18536 36 4 1153582 -016808
FO04EE 8 2295699 5 1150954 20118 s s e
FOE054.6 2429068 3 1165085 02193 T
BOT4T4ET 2712236 7 1170775 024511
805382.3 | -29156.04 [ 1174875 0.26348 b L LI
FEEEE3N; 2151067 g 1139552 019444
FrZE0Y 2354425 10 1143634 -DZidaz 00,0 08y, any,
TIOAT2E | 2720488 11 1151076 -0.24583
FO40404 2923857 12 1155178 026427 88 ee s
792267231 3283920 13 1162560 029733
FOREE00 3403208 14 11.BEEET ket =) ee e
FEBO9GS 3110074 15 1139086 028113 e as se
7E1527.81 -29067.06 1E 1134985 26478
HFFRRR 71 -T1433 R7 17 11 71531 - R4RARR ;J — e e
4 I =

Runz the compiled script

96. Ajouter deux colonnes « Lat dd » et « Long dd » en allant a « Edit », puis « Add Field », mettre le
nombre de chiffre apres le point ;

NB : 1l faut d’abord cliquer sur « Attribues du tableau », ensuite aller & « theme » sur le barre des menu,

puis « Start Editing » ;

97. Cliquer sur I’entéte d’une des nouvelles colonnes, Ensuite aller & « Calculate »

98., puis double clique dans « Field » la colonne correspondant a celle qu’on veut mettre dans les

nouvelles colonnes

Extrait du version Frangais de :

Maisels, F., and R. Aba'a. 2010. Section 3: Survey design. Page 16 in M. Kiuhl H., F., Ancrenaz, M., and

Williamson, E.A. , editor. Best Practice Guidelines for Surveys and Monitoring of Great Ape Populations.
IUCN Ape Species Specialist Group.



! Arc¥iew GIS 3.2a

File Edit Table Field “indow Help

A EAE]
| Dof| BE selected k| In€¥] |colculste

#! Attributes of Df_trans.shp

Shape | Transect| Débutfin] - Utm Lt » H-ooord “r-coord
Pt 1:Début  800887.6¢ -17036.00 1 11.70300 015396
Puirt 1:Fin 796319.9 ¢ -15002.32 2 11.66193 013558
Pt 2iDébut  77FESY.2 ¢ -1E5E2.EE 3 11.49481 014570
Puirt 2iFin 78226491 -18596.36 4 11.53582 -0.16508
Paint 3iDébut  790486.8 ¢ -22256.93 5 11.60964 020116
Puirt 3iFin 795054.6 | -24290.68 E 11.66065 021553
Pt 4:Début 8014146 2712236 7 11.70775 024511
Puirt 4:Fin 805982.3 | -29156.04 o 11.74875 0.26348
Poirt 5iDébut  7EEESA.0: -21510.57 3 11.39592 019444
Puirt 5:Fin 7712607 | -23544 25 10 11.43694 021282
Puirt E:Début 7734726 -27204.83 11 11.51076 -0.24583
Puirt E: Fin 784040.4 | -29238 57 12 11.56178 0. 26427
Puirt 7iDébut 79226231 -32893.20 13 11.62560 029733
Puirt 7iFin 796830.0 | -34532.88 14 11.6REE1 031570
Puirt 8:Début  :7EEDS5.5: -31100.74 15 11.39066 028113
Puirt 8:Fin 7E1627.8 | -29067.06 1B 11.34965 0. 26276
Puirt 9iDébut  B02686.7 ¢ 7143362 17 11.7193 -0.64555
Pait 9: Fin 798687.3 ¢ -71363.80 18 11.68341 064494
Puirt 10 Début i 7H3688.81 -71189.28 19 11.59364 064341
Pt 10 Fin 7846894 1 -71119.48 20 11.56774 064279
Puirt 11iDébut 17746309 -70344.95 21 11.46796 064126
Pt 11 : Fin 770691.6 ¢ -70875.14 22 11.43205 064065
Puirt 12iDébut 17633589 -B0835.95 23 11.41115 073070
Pt 12 Fin 7723583 ¢ -B0905.76 24 11.44706 07313
Puirt 13iDébut 17823568 -81080.28 25 11.53684 073283
Pt 13 Fin 7863561 | -81150.09 26 11.57275 073344
Puirt 14:Début  7IE3546 1 -B1324 62 27 11.66252 073457
Pt 14 : Fin 800354.0 ¢ -81394.42 28 11.69842 -0.73558

! Field Calculator x
Fields Type Requests
f*  Mumbes N =

[Tranzect] S +

[0 £but/fin] 20 R =

(Ut #] " Date .

[Uten y) / '

[\ aypaint] <

[Lat dd] A <= hd|
[Lat dd] =

.

99. Exporter en texte ladite table, en allant a « File », puis « Export »

100. Choisir la localisation de la table, donner lui un nom et préciser le type d’enregistrement. Dans
notre cas, c’est « texte ou txt »

101. 1l faut faire chercher le Shapefile les lignes des transects linéaires qui se trouve dans « New
design » contenu dans le dossier Distance ; mettez I’image d’ou il se trouve
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& [#] IS

o Df trans_dd.shp %

ﬂ Hew_desS.shp

ﬂ Strata.zhp

-

Doc_Study_Design - Micr. ..

ﬂ;fDémarrerl ﬁ Study design | @ IUCH_SGA_Monitoring_S... ||a ArcYiew GIS 3.2a

Faire les transects plus visible sur cette carte
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